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SWOP
™

 Application Data Sheet 

 
 

QUATO Intelliproof 213 
Soft Proofing System   

using Adobe Photoshop CS2 
 and ICS Remote Director  
 
 
The SWOP™ Review Committee has approved the use of off-press proofs as input material to publications. 
SWOP Specifications recommend that: “the appearance of an off-press proof must closely simulate a SWOP 
press proof.” 

 
 

1. Manufacturer: Quatographic Technology Gmbh 
Osterbergstr. 14a 
38112 Braunschweig 
Germany 
+49 – (0)531 – 281 38-1 

    
 
                        
          

2. Products:  Quato Intelliproof 213 TFT Display 
Quato IColor Software 
ICS Remote Director 3.2 
 
Also Required: 
X-Rite DTP94 Optix Colorimeter 
Adobe Photoshop CS2 
GTI Viewing Booth 
 

 
 
          
3. Introduction 
 
The Quato Intelliproof 213 TFT precision display with IColor software provides a completely integrated 
calibration and profiling solution that allows users to create SWOP Certified soft proofs using Adobe 
Photoshop CS2.  
          
When combined with ICS Remote Director, the Quato Intelliproof 213 TFT display provides a Remote Soft 
Proofing solution with additional calibration and verification to the SWOP Certified Application Data Sheet. 
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4. Control Guide 
 
SWOP specifies that a control guide such as the SWOP Proofing Bar or other suitable guides that meet these 
requirements be supplied on every off-press proof. As a minimum, this guide should contain solids of the 
primaries and two color overprints, as well as a 75%, 50% and 25% tint of each of the process colors. 
Including a control strip in each soft proofed image is the responsibility of the user. 
 
Quato provides a Quato_SWOPcontrolbar_horiz.tif file for use in verification in Adobe Photoshop CS2. 
 
ICS provides a SWOP control bar for use in verification in Remote Director. 

 
 
5. System Components/Set Up Conditions 

 
 

Environment: 
The room where the Quato Intelliproof 213 Proofing system is installed must have controlled lighting. 
Room lighting incident at the monitor and viewing booth plane MUST not exceed 30% and 
SHOULD not exceed 10% of the dimmed booth brightness. The room walls should be 
neutral gray and the room lighting should be D50 color with no direct entry of daylight. 
 
Viewing booth: 
A variable-intensity monitor-side viewing station with D50 reflective lighting. 
Best: GTI SOFV-1Ex 
Good: GTI SOFV-1E or 2E 
Acceptable: GTI PDV-3D 
 
Viewing: 
Viewing angle is an important consideration when soft proofing. The user should only judge color 
when sitting directly in front of, and perpendicular to, the display. The viewing station should be 
angled so that the viewer can make comparisons without changing their viewing angle relative to the 
display. The section ‘Viewing Instructions’ explains how to compare a soft proof to a hard copy proof. 
 
Pre-Installation 

• Download the Quato Soft Proof SWOP set-up files from the following location and 
uncompress them to you hard drive 

• http://www.chromaticity.com/quato/quatoswop2006.zip 

QUATO Intelliproof 213 Soft Proofing 
System with ICS Remote Director 

 

• QUATO Intelliproof 213 Precision 
TFT Display 

• QUATO IColor software 

• ICS Remote Director 3.2 

• X-Rite DTP94 Optix Colorimeter 

• Viewing Booth 

• Environment 

 

QUATO Intelliproof 213 Soft Proofing 
System with Adobe Photoshop CS2 

 

• QUATO Intelliproof 213 Precision 
TFT Display 

• QUATO IColor software 

• X-Rite DTP94 Optix Colorimeter 

• Adobe Photoshop CS2 

• Viewing Booth 

• Environment 
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Quato Intelliproof 213 and Quato IColor Software 

• Install Quato display and IColor software per manufacturer instructions 

• Calibrate the display using the following parameters in IColor 
o Hardware Calibration for Intelli Proof Displays 
o Gamma: 2.3 
o White Point: 5000K 
o Luminance: Maximum 
o Profile Calculation: LUT 

• After calibration is completed, save the profile as a LUT-profile . 

• Select this new profile and activate it according to the instructions in the software. 

• Using the Test option in IColor, verify the accuracy of the profile and calibration using the 
Profile Validation option. The Test process should report all colors with a Delta E CIE 94 
result of less than 2.0 Delta E. 

 
 

Adobe Photoshop CS2 

• Locate the ICC profile named “Quato_SWOP_2006_0320.ICC” from the uncompressed 
SWOP set-up files that you downloaded as part of pre-installation and install it in to the 
appropriate area of your operating system so that Photoshop can use it. 

• From the View Menu in Photoshop choose: Proof Setup, then Custom 

• In the Custom dialog, choose the “Quato_SWOP_2006_0320.ICC” profile and make sure that 
both Preserve CMYK Numbers and Simulate Paper Color are selected. This will ensure that 
you are properly viewing a SWOP proof in Photoshop. 

• Verify your set-up by measuring the “Quato_SWOPcontrolbar_horiz.tif” using the Quato 
IColor application as directed in section 7 of this document. 

 
 

ICS Remote Director 

• Prior to launching ICS Remote Director place the following files in the appropriate location on 
the hard drive. 

o Copy the profile: “ICS SWOP Validate.icc” into the Profile directory located in 
Applications(Program Files)/ICS Color Software/Remote Director/Support/Profiles. 
Overwrite the existing profile that is already installed in this location 

o ICS Remote Director will also install another profile with this same name in some 
other location on your hard drive appropriate for your operating system. Locate this 
directory and also copy this same profile “ICS SWOP Validate.icc” into that location 
as well, again choosing to overwrite the existing profile 

o Copy the file: “ICS_SWOP_Quato_Display.CIE” into the SWOP Certified Displays 
directory located in Applications(Program Files)/ICS Color Software/Remote Director/ 
SWOP Certified Displays 

o Launch Remote Director and Select Prepare Proof… from the File menu, name the 
job something like “SWOP Test”, and click OK. 

o In the palette that follows set Color Temperature to D50 and Luminance to Maximum, 
then click Add Files… 

o Navigate to the file(s) you wish to proof. Highlight the file or files and click Add then 
Done. Your files will be displayed in Remote Director’s main window. NOTE: PDF’s 
should be rasterized at minimum of 150 DPI (Remote Director default) for proper 
color viewing. 

o Select Display – Calibrate from the menu bar and the Remote Director Display 
Calibrator palette will appear. 

o Follow the instructions as Remote Director builds the monitor profile. NOTE: This will 
take several minutes, during which time room lighting must remain absolutely 
constant. If the ambient room lighting changes for any reason, re-start the calibration 
process. 
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o When calibration is finished, the file will be displayed with the default CMYK source 

profile. Open the Color Management palette from the Tools menu and select the 
profile named “ICS SWOP Validate” in the Source Profile – Custom popup list. Be 
sure to activate the radio button alongside the list to make the selection active.  

 
 

6. Viewing Instructions 
 
This section is included to ensure the best possible comparison between the soft proofing screen and an 
actual hard-copy proof. Because today’s monitor technologies cannot achieve the illumination intensity of a 
standard pre-press viewing booth, a soft proof will appear too dark when compared to a hard copy proof 
illuminated in a standard graphic arts viewing booth. A dimmable D50 viewing booth located alongside the 
monitor solves this problem. 
 

• Adjust the light intensity of the viewing booth so that the base material (paper) of the hard-
copy proof is the same apparent brightness as the simulated paper on the soft proof. To 
display a large area of simulated proofing paper, slide the Matte control in the Navigation tool 
to the right. NOTE: The brightness level to which the viewing booth must be dimmed depends 
on the age and calibration settings of the monitor, as well as the evenness of light distribution 
within the viewing booth itself. Owing to the wide range of variables, the dimming process is 
best governed by subjective judgment rather than instrumentation. 

• Note that all viewing booths exhibit some lighting unevenness, usually appearing brighter 
nearer the light source. This unevenness is typically worse in smaller booths and can 
significantly affect the apparent match between a soft proof and a hard-copy proof. Viewing 
booths which illuminate from two or more directions, such as the GTI SOFV-1EX, largely 
eliminate this problem. 

• Check the viewing booth for evenness and decide the best position in which to place the hard 
copy proof. When viewing very large hard-copy proofs it may be necessary to adjust the 
booth intensity so that the area of interest is illuminated to the same brightness as the 
monitor. 

• Image size can affect apparent matching quality. For the most critical match, adjust the soft 
proof to the same magnification as the hard copy proof. 

 
 
7. Finished Proof Characteristics 
 
A properly prepared SWOP proof on a Quato Intelliproof 213 display can be verified in Adobe Photoshop CS2 
using the supplied Quato SWOP Control bar and The Quato IColor application.  
 
A properly prepared SWOP proof on a Quato Intelliproof 213 display can be verified in ICS RemoteDirector 
3.2 using the ICS digital SWOP control bar and the SWOP verification tool. 
 
All measurements above were made using a calibrated X-Rite DTP94 Optix Colorimeter. Colorimetric 
measurements were done under D50 Illuminant, 2º observer. 
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Verification in Adobe Photoshop CS2 

• Open and the file: “Quato_SWOPcontrolbar_horiz.tif” in Photoshop CS2 and set the 
viewing size of the file to 200% in Photoshop. 

• Ensure that Photoshop CS2 is set-up correctly for soft proofing as described in section 5 
of this document. 

• Launch the Quato IColor application and verify that the calibration and profile are valid to 
less than a Delta E of 2.0 as described in section 5 of this document. 

• Validate the Quato display by following the instruction in the SWOP validation tool. First 
measure the white patch in the Quato application before moving the proper patches of 
the “Quato_SWOPcontrolbar_horiz.tif” file in Photoshop in front of the X-Rite DTP94 
instrument and measuring each patch in the order instructed. 

• The Delta E values should remain less than 3.0 Delta E for a SWOP Certified display 
system in Adobe Photoshop CS2. 

• If the systems passed certification a SWOP logo will appear and a report of the validation 
process can be saved and printed. 

 

Adobe Photoshop CS2 SWOP Reference Data      

         

 Patch CMYK   Target CIE L*a*b*  Delta E CIE 94 

Patch Description % Cyan % Magenta % Yellow % Black CIE L* CIE a* CIE b* Max Delta E 

C100 100 0 0 0 57.4 -27.3 -39.6 3 

C75 75 0 0 0 63.8 -26.5 -32.9 3 

C50 50 0 0 0 74 -16.9 -20.1 3 

C25 25 0 0 0 84 -8.7 -9.4 3 

M100 0 100 0 0 48.6 66.8 -2.3 3 

M75 0 75 0 0 56.4 53 -3.6 3 

M50 0 50 0 0 69 32.2 -2.5 3 

M25 0 25 0 0 82.7 14 -1 3 

Y100 0 0 100 0 88 -4.5 76.1 3 

Y75 0 0 75 0 89.4 -3.9 60.3 3 

Y50 0 0 50 0 90.4 -3.7 38.1 3 

Y25 0 0 25 0 91.9 -2.1 19.9 3 

K100 0 0 0 100 20.8 0.7 2.4 3 

K75 0 0 0 75 38.2 -0.1 -0.4 3 

K50 0 0 0 50 56.9 -0.4 -0.7 3 

K25 0 0 0 25 71.8 -0.7 -0.4 3 

R100 0 100 100 0 48.3 62.6 37.3 3 

R75 0 75 75 0 55.5 50.3 32.4 3 

R50 0 50 50 0 67.5 30.7 24.4 3 

R25 0 25 25 0 81.3 11.4 15 3 

G100 100 0 100 0 52.3 -56.5 24.2 3 

G75 75 0 75 0 59.8 -42.6 18.3 3 

G50 50 0 50 0 72.1 -24.3 13.2 3 

G25 25 0 25 0 83.3 -11.8 8.1 3 

B100 100 100 0 0 27.4 12.9 -42.9 3 

B75 75 75 0 0 36.9 16 -35.4 3 

B50 50 50 0 0 54.5 12.9 -22.3 3 

B25 25 25 0 0 74.3 5.2 -11.7 3 

P 0 0 0 0 92.8 0.3 2 3 
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Verification in ICS Remote Director 
 

• To verify that the displayed proof meets this application data sheet you can measure your 
display’s rendition of a Virtual Proofing Bar using Remote Director’s Verify SWOP 
selection from the Display option in the menu bar. 

• Standard measured values for each ‘patch’ in the proofing bar (listed below) are stored 
as a data set within Remote Director. During the Verify SWOP function these stored 
values are compared to the measured values and an average Delta E (color difference) is 
displayed, along with a peak value for the patch with most difference. 

• If your average Delta E and peak value Delta E are less than 3.0, your display is within 
the ADS specification of color matching. 

 

ICS Remote Director SWOP Reference Data     

         

 Patch CMYK   Target CIE L*a*b*  Delta E CIE 94 

Patch Description % Cyan % Magenta % Yellow % Black CIE L* CIE a* CIE b* Max Delta E 

Cyan 100 0 0 0 54.9 -27.1 -38.1 3 

Magenta 0 100 0 0 46.0 66.3 -2.6 3 

Yellow 0 0 100 0 85.9 -4.0 74.3 3 

Black 0 0 0 100 17.5 0.9 1.0 3 

Red 0 100 100 0 45.5 62.0 34.1 3 

Green 100 0 100 0 48.8 -52.3 19.8 3 

Blue 100 100 0 0 25.7 9.5 -39.2 3 

Cyan75 75 0 0 0 61.9 -27.3 -30.8 3 

Magenta75 0 75 0 0 55.3 49.8 -3.3 3 

Yellow75 0 0 75 0 87.2 -4.7 57.4 3 

Black75 0 0 0 75 36.5 0.5 -0.9 3 

Gray75 75 63 63 0 38.0 -2.8 -4.9 3 

Red75 0 75 75 0 53.8 46.9 30.9 3 

Green75 75 0 75 0 57.5 -38.6 16.0 3 

Blue75 75 75 0 0 35.8 12.7 -31.7 3 

Cyan50 50 0 0 0 72.6 -16.8 -19.3 3 

Magenta50 0 50 0 0 68.2 29.6 -2.6 3 

Yellow50 0 0 50 0 88.5 -3.9 35.4 3 

Black50 0 0 0 50 53.9 0.0 -1.4 3 

Gray50 50 39 39 0 54.2 0.0 -0.9 3 

Red50 0 50 50 0 66.5 27.7 23.7 3 

Green50 50 0 50 0 69.0 -23.1 12.3 3 

Blue50 50 50 0 0 52.6 10.1 -21.6 3 

Cyan25 25 0 0 0 82.0 -8.7 -8.8 3 

Magenta25 0 25 0 0 80.5 13.0 -0.4 3 

Yellow25 0 0 25 0 89.5 -2.0 18.2 3 

Black25 0 0 0 25 68.8 -0.5 0.1 3 

Gray25 25 16 16 0 74.6 -2.5 -0.3 3 

Red25 0 25 25 0 79.6 11.2 14.9 3 

Green25 25 0 25 0 80.4 -10.4 7.8 3 

Blue25 25 25 0 0 71.6 4.5 -11.2 3 

White 0 0 0 0 91.3 -0.4 1.8 3 
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8. Sample Proofs 
 
Chromaticity Incorporated has demonstrated a QUATO Intelliproof 213 Soft Proofing System that conforms to 
this SWOP Application Data Sheet to the SWOP Technical Committee for analysis and verification. 

 


